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UNIT OVERVIEW

Matter and Energy

Summary

The Matter and Energy Module consists of four sequential investigations to introduce the multiple forms that matter and energy can
take and to give students experience with the transfer of energy from one form to another. Light absorption and reflection is the focus
of an entire investigation. Students also conduct and observe chemical reactions and are introduced to atoms and elements.

Enduring Understanding:

Essential Questions: Overarching

Students will understand that.....

Energy makes things happen.

Energy takes many forms.

Energy can be stored.

Most of the energy used by organisms, including humans,
comes from the Sun in the form of light.

Stored energy can be converted to other forms of energy.
Machines and living things can convert energy into motion
and heat.

Energy can be carried from one place to another by waves,
electric current and moving objects.

Light is a form of energy that travels in straight lines from a
light source.

Light can reflect (bounce off) surfaces that it strikes.

A mirror is a smooth, reflective surface.

An object is seen only when light from that object enters an
eye.

White light is a mixture of all colors of light.

Light can be absorbed by matter.

The apparent color of an object is the result of the light it
reflects.

The apparent color of an object is affected by the color of
light striking it.

A shadow is created when an opaque object blocks light.
Common matter on Earth has three forms (states): solid,
liquid, and gas.

The behavior of a sample of matter in an open container
indicates its state.

Measurement is used to quantify observations.

A measurement standard is a unit agreed upon and used by a
large number of people.

The gram (g) is the standard unit of measure used to quantify
mass in the metric system.

Volume is a measure of the three-dimensional space
occupied by matter.

Opinion is based on belief; scientific evidence is based on
observation.

The liter (L) is the standard for measuring fluid volume in
the metric system.

Degree Celsius ("C) is the unit used when scientists measure
temperature.

Melting occurs when solids are heated.

Different substances melt at different temperatures.
Evaporation occurs when liquids are heated.

All matter on Earth is made of tiny particles.

When two substances are combined, a reaction may occur,
producing a new substance with unique properties.

What does energy do?

Where can energy be stored?

What are some different sources of energy?

What are some ways energy is converted (changed) from one
form to another?

How does energy move from one place to another?

How can you change the direction light travels?

What happens when white light strikes an object?

What happens when colored light strikes an object?

What are the properties of solids, liquids, and gases?

What is mass?

How can you measure the mass of an object?

What is volume?

How can you measure the volume of a liquid?

How can you measure the temperature of a liquid?

How can you melt a solid?

What happens to the water in a container if you leave it out and
heat it up?

e  What happens when you mix baking soda and vinegar?




Knowledge:

Skills:

Student will Know....

Light from the Sun is the source of most of the energy on
Earth.

Organisms use stored energy in food as fuel for life
processes.

Energy can be converted from one form to another.

Energy can be carried from one place to another by waves,
electric current and moving objects.

Organisms and machines convert stored energy to motion
and heat.

Light is a form of energy that travels in straight lines from a
light source.

Light can reflect from the surface of a mirror.

An object is seen only when light from that object enters the
eye.

White light is a mixture of all colors of light.

Light can be absorbed and reflected by matter.

Apparent color on an object is the result of the light it
reflects.

Apparent color of an object is affected by the color of light
striking it.

The defining characteristics of solids, liquids, and gases.
The standard metric units for measuring mass and volume;
the gram and the liter.

How to use a balance to determine and compare masses.
How to use graduated cylinders and syringes to measure and
compare volumes of liquids.

How to measure temperature in standard metric units using a
thermometer calibrated in degrees Celsius.

Heat affects the rate of evaporation of liquid water.

That all matter is made of tiny particles.

Melting occurs when solids are heated.

When two substances are combined, a reaction may occur,
producing a new substance with unique properties.

Students will be able to...

Identify sources of stored energy.

Learn that light from the sun is the source of most of the
energy on Earth.

Observe energy sources doing work.

Learn how organisms used stored energy in food as fuel from
life processes.

Learn how energy can be converted from one form to another.
Observe that energy can be carried from one place to another
by waves, electric current, and moving objects

Learn that organisms and machines convert stored energy to
motion and heat.

Learn that light is a form of energy that travels in straight lines
from a light source.

Find out how light can reflect (bounce off) from the surface of
a mirror.

Learn that an object is seen only when light from that object
enters the eye.

Learn that white light is a mixture of all colors of light.

Learn that light can be absorbed and reflected by matter.
Learn that the apparent color of an object is the result of the
light it reflects.

Observe that the apparent color of an object is affected by the
color of light striking it.

Predict outcomes of investigations and compare to results.
Explore properties of the three forms of matter, solid, liquid,
and gas.

Determine defining characteristics of solids, liquids and gases.
Learn the standard metric units for measuring mass and
volume; the gram and the liter.

Use a balance to determine and compare masses.

Use graduated cylinders and syringes to measure and compare
volumes of liquids.

Make multiple observations to improve accuracy.

Make predictions and compare them to data.

Collect and use data to draw conclusions.

Differentiate evidence from opinion.

Measure temperature in standard metric units using a
thermometer calibrated in degrees Celsius.

Melt solid substances using heat.

Learn that heat affects the rate of evaporation of liquid water.
Conduct a simple chemical reaction and compare the products
to the original substances that reacted.

Learn that all matter is made of tiny particles.

Make predictions in the context of conducting science
investigations.

Use numerical data collected in an investigation to compare
results and develop conclusions.

Evidence of Understanding:

Pre- Assessment, [-Check Assessments, Unit Assessments
Notebook and Journal Entries

Performance Assessments

Reading Prompts

Student Observation/Anecdotal Notes

Homework




Preconception /Misconceptions

Matter

Gases are not matter.

Matter is something that can be handled and takes up space.
Energy is an ingredient in matter.

Matter is continuous.

The space between particles is filled.

Expansion of matter is due to the expansion of particles, rather than an increase of particle spacing.
Gases are not matter because they are invisible.

Gas has no weight - even if it has color it has no weight.
Gases weigh less than the materials that created them.

Air neither has mass nor can it occupy space.

When gases expand more gas is present.

List other that you discover in your class:

Energy

o Energy is truly lost in many energy transformations.

There is no relationship between matter and energy.

If energy is conserved, why are we running out of it?

Energy can be changed completely from one form to another (no energy losses).

e Things “use up” energy.

e Energy is confined to some particular origin, such as what we get from food or what the electric
company sells.

e An object at rest has no energy.

The only type of potential energy is gravitational.

Doubling the speed of a moving object doubles the kinetic energy.

e Energy is a “thing.” This is a fuzzy notion, probably because of the way we talk about newton-
meters or joules. It is difficult to imagine an “amount” of an abstraction.

o The terms “energy” and “force” are interchangeable.

List other that you discover in your class:




New Jersey Common Core Standards

5.1 Science | All students will understand that science is both a body of knowledge and an evidence-based, model-

Practices building enterprise that continually extends, refines, and revises knowledge. The four Science Practices
strands encompass the knowledge and reasoning skills that students must acquire to be proficient in
science.

Strand A Understand Scientific Explanations: Students understand core concepts and principles of science
and use measurement and observation tools to assist in categorizing, representing, and interpreting
the natural and designed world. Who, what, when, where, why, and how questions form the basis for
young learners’ investigations during sensory explorations, experimentation, and focused inquiry

5.1.4.A.1 Fundamental scientific concepts and principles and the links between them are more useful than discrete
facts.

5.1.4.A.2 Outcomes of investigations are used to build and refine questions, models, and explanations.

Strand B Generate Scientific Evidence Through Active Investigations: Observations and investigations form
young learners’ understandings of science concepts.

5.1.4.B.2 Tools and technology are used to gather, analyze, and communicate results.

5.1.4.B.3 Evidence is used to construct and defend arguments

5.1.4.B.4 Reasoning is used to support scientific conclusions.

Stand C Reflect on Scientific Knowledge: Interacting with peers and adults to share questions and
explorations about the natural world builds young learners’ scientific knowledge.

5.14.C.1 Scientific understanding changes over time as new evidence and updated arguments emerge.

5.1.4.C.2 Revisions of predictions and explanations occur when new arguments emerge that account more
completely for available evidence.

Strand D Participate Productively in Science: Science practices include drawing or “writing” on observation
clipboards, making rubbings, or charting the growth of plants.

5.1.4.D.1 Science has unique norms for participation. These include adopting a critical stance, demonstrating a
willingness to ask questions and seek help, and developing a sense of trust and skepticism.

5.14.D.2 In order to determine which arguments and explanations are most persuasive, communities of learners
work collaboratively to pose, refine, and evaluate questions, investigations, models, and theories (e.g.,
scientific argumentation and representation).

5.1.4D.3 Instruments of measurement can be used to safely gather accurate information for making scientific
comparisons of objects and events.

5.2 Physical | All students will understand that physical science principles, including fundamental ideas about matter,

Science energy, and motion, are powerful conceptual tools for making sense of phenomena in physical, living, and
Earth systems science.

Strand A All objects and substances in the natural world are composed of matter. Matter has two fundamental
properties: matter takes up space, and matter has inertia.

5.2.4.A2 Each state of matter has unique properties (e.g., gases can be compressed, while solids and liquids cannot;
the shape of a solid is independent of its container; liquids and gases take the shape of their containers).

5.2.4.A3 Objects and substances have properties, such as weight and volume, that can be measured using
appropriate tools. Unknown substances can sometimes be identified by their properties.

5.4 Earth All students will understand that Earth operates as a set of complex, dynamic, and interconnected systems,

Science and is a part of the all-encompassing system of the universe.

Strand G Biogeochemical Cycles: The biogeochemical cycles in the Earth systems include the flow of microscopic
and macroscopic resources from one reservoir in the hydrosphere, geosphere, atmosphere, or biosphere to
another, are driven by Earth's internal and external sources of energy, and are impacted by human activity..

544.G3 Most of Earth’s surface is covered by water. Water circulates through the crust, oceans, and atmosphere in

what is known as the water cycle.




Next Generation Science Standards

Performance Expectations

2-PS1-1 Plan and conduct an investigation to describe and classify kinds of materials by their observable properties.
2-PS1-4 Construct an argument with evidence that some changes caused by heating or cooling can be reversed and some
cannot.

Planning and Carrying Out Investigations: Planning and carrying out investigations to answer questions or test solutions
to problems in K-2 builds on prior expe3rience and progresses to simple investigations, based on fair tests, which provide
data to support explanations or design solutions.

e Plan and conduct an investigation collaboratively to produce data to serve as the basis for evidence, to answer a

question. (2-PS1-1)
Constructing Explanations and Designing solutions in 3-5 builds on K-2 experiences and progresses the use of evidence
and ideas in constructing evidence-based accounts of natural phenomena and designing solutions
* Obtain and combine information from books and other reliable media to explain phenomena.

Engaging in Argument from Evidence Builds on prior knowledge and progresses to comparing ideas and representations
about the natural and designed worlds —Construct an argument with evidence to support a claim (2-PS1-4)
Science Models, Laws, Mechanisms, and Theories Explain Natural Phenomena Scientistws search for cause and effect
relationships to explain natural events (2-PS1-4)

o Different kinds of matter exist and many of them can be either solid or liquid, depending on temperature. Matter
can be described and classified by its observable properties. PS1.A

e Heating or cooling a substance may cause changes that can be observed. Sometimes these changes are reversible,
and sometimes they are not. PS1.B Chemical Reactions 2- PS1-4

Patterns. Patterns in the natural and human designed world can be observed. (2-PS1-1)
Cause and Effect, Events have causes that generate observable patterns (2-PS1-4)




Common Core State Standards

Reading Informational Text

RI.3.10 Ask and answer questions to demonstrate understanding of a text, referring explicitly to the text as the
basis for the answers.

RI3.3 Describe the relationship between a series of historical events, scientific ideas or concepts, or steps in
technical procedures in a text, using language that pertains to time, sequence, and cause/effect.

RI3.9 Compare and contrast the most important points and key details presented in two texts on the same
topic

W.3.1 Write opinion pieces on topics or texts, supporting a point of view with reasons.

W.3.2 Write informative/explanatory texts to examine a topic and convey ideas and information clearly.

SL.3.1 Write informative/explanatory texts to examine a topic and convey ideas and information clearly..

SL3.2. Determine the main ideas and supporting details of a text read aloud or information presented in diverse
media and formats, including visually, quantitatively, and orally.

SL.3.2 Ask and answer questions about information from a speaker, offering appropriate elaboration and detail

3.MD.B.3 Measurement and data: Draw a scaled picture graph and a scaled bar graph to represent a data set with

several categories. Solve one- and two-step "how many more" and "how many less" problems using
information presented in scaled bar graphs.

Check that all materials are available, usable, and ready
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Investigation 1
Energy

Summary

Students investigate different forms of energy (light, heat, sound, and motion) and determine ways that energy is converted
to make things happen. They explore ways that energy forms are carried from one place to another.

Core Conceptual Ideas

» Energy makes things happen
» Energy takes many forms
» Most of the energy used by organisms, including humans, comes from the Sun in the form of light.
» Stored energy can be converted to other forms of energy.
» Energy can be carried from one place to another by waves, electric current, and moving objects
New Vocabulary Extensions
Battery, chemical energy, convert, electric current, Math Extension-Problem of the Week pg 23 of science
electricity, energy, energy source, energy transfer, food, resources

forms of energy, fossil fuel, fuel, heat, light, moving object, | Science Extension- Start an Energy Toy collection

stored energy, Sun, wave

Part .11 - “Energy Sources”

Summary

Students investigate different sources of energy. They use batteries to turn on a flashlight, run a motor, and create sound; a
candle to create a flame, a solar cell to convert light into movement, and rubbing their hands to generate heat. They develop
a definition of energy. It makes things happen.

Understandings

> Energy makes things happen
> Energy takes many forms,
» Energy can be stored.
» Most of the energy used by organisms, including humans, comes formthe Sun in the form of light.
Focus Questions
» What does energy do?
» Where can energy be stored?
» What are some different sources of energy??
Teacher Preparation Body Of Evidence Est. Time
» Pre- Assessment 3 Sessions
» Send Letter to Parents Home (Teacher » Notebook Investigation Entry
Master ) » Reading: Foss Student text Energy Sources pg 1
» Read TE “At A Glance”, “Background for » Writing Prompt: Review Questions
the Teacher” &“Teaching Children About » Journal Entry
Energy” » Student Observation/ Anecdotal Notes
» Watch Video Demonstration of Inv. 1 Partl Individual Work
» Review » Homework
“ Materials” “Getting Ready”&“Guiding the | > Cross Curriculum Extensions
Investigation” » Informational Text
» Prepare materials Scores sent to District
Data to be recorded in Genesis
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Part 1.2 — Converting Energy

Summary
Students determine the various ways that energy is converted to make different things happen. They use cards to match

different stored energy sources with what the sources can make happen.

Understandings
» Stored energy can converted to other forms of energy.
» Machines and living things can convert energy into motion and heat.

Focus Question
» What are some ways energy is converted (changed) from one form to another?

Teacher Preparation Body Of Evidence Est. Time

» Watch Video Demo of Inv.1 Part 2 Notebook Investigation Entry 3
» Review “Materials” and “Getting Ready” Reading: FOSS Student text Energy Conversion pg. 8 | sessions
&“Guiding the Investigation” Writing Prompt: Review Questions p.8

» Prepare materials Journal Entry

I Check 1 — Step 20

Student Observation/Anecdotal Notes

Homework
Individual work

» Cross Curriculum Extensions

» Information Text

VVVVYVVYY

Part 1.3 — Energy on the Move

Summary
Students investigate different ways that energy can be carried from one place to another. They visit stations that demonstrate

energy carried in wires by electric current, in the air by sound waves, by rolling objects, and by a spring toy. In a class
demonstration, students observe waves carrying energy in water.

Understandings
» Energy can be carried from one place to another by waves, electric current, and moving objects.

Focus Question
» How does energy move from one place to another?

Teacher Preparation Body Of Evidence Est. Time
”? » Notebook Investigation Entry 5 sessions
» Watch Video Demonstration of Inv. 1 Part 3 » Reading: FOSS Student text Energy on the Move pg.
» Review “ Materials” “Getting Ready” 14
&“Guiding the Investigation” » Writing Prompt: Review Questions
» Prepare materials » Journal Entry
» 1Check 1— Step 20
» Student Observation/Anecdotal Notes
» Homework
Individual work
» Cross Curriculum Extensions
Information Text

Suggested Center Activities: Rising Reader Readorium, Spelling City; FOSS Digital Resources: eBook, Audio Stories;
suggested websites; word wall activities; extension activities; and additional supporting Science activities.

Culminating Activity: Begin planning with students culminating project. Suggestions:
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Investigation 2 “Light”

Summary

Students use mirrors to reflect light and learn that light travels in straight lines. They are introduced to blocked light
(shadows), light absorption, and white light as a mixture of all colors of light. They investigate first hand and
through simulations, video, and readings how the appearance of an object is affected by the color of light striking it.

Concepts:
Light is a form of energy that travels in straight lines from a light source.

Light can reflect off surfaces that it strikes.

An object is seen only when light from that object enters an eye.

White light is a mixture of all colors.

Light can be absorbed by matter.

The apparent color of an object is affected by the color of light striking it.

VVVVVYY

New Vocabulary Investigation 2 Extensions

Absorb, appearance, color, light source, mirror, ray, reflect, | Math - Problem of the Week pg. 38 Science Resources

reflection, shadow, white light Language — Write Mirror Messages

a Periscope

Science- Share Light. Look at symmetry of faces, Make

Part 2.1 — “Reflected Light”

Summary

Students use mirrors to experience the reflections of light. They start by using mirrors outside to discover how to see
objects behind them and to reflect a bright spot onto walls. In the classroom, they determine that a mirror can be used to
reflect light, that is, to change its direction of travel. Students use flashlights and mirrors to reflect light in numerous ways,

reinforcing the idea that light can reflect from surfaces.

Understandings
» Light is a form of energy that travels in straight \lines from a light source.
» Light can reflect (bounce off) surfaces that it strikes
» A mirror is a smooth reflective, surface.

Focus Question
» How can you change the direction light travels?

Teacher Preparation Body Of Evidence Est. Time
> Read TE » Notebook Investigation Entry 2 sessions
“At A Glance”, “Background for the Teacher”’& |» Reading: FOSS Student text Reflection pg 24
“Light” » Writing Prompt: Review Questions p. 28
» Watch Video Demonstration of Inv. 2 Partl » Journal Entry
> Review » Student Observation/Anecdotal Notes
“ Materials” “Getting Ready” &“Guiding the » Journal Entry
Investigation” » Homework (Suggestions)
» Prepare materials » Cross Curriculum Extensions
» Show students video about light and shadows » Information Text

and have them read expository article about color
and vision.
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Part 2.2 “— Colored Light”

Summary
Students are introduced to the idea of light absorption and the definition of white light as a mixture of all colors of light.

They use gels and tubes to create colored-light environments into which they can place small colored plastic cubes.
Students observe that the apparent color of the cubes is affected by the color of the light striking them inside the tubes.

Understandings

White light is a mixture of all colors of light

Light can be absorbed by matter.

The apparent color of an object is the result of the light it reflects.

The apparent color of an object is affected by the color of light striking it.
A shadow is created when an opaque object blocks light.

YVVVYY

Focus Questions

» What happens when white light strikes an object?
» What happens when colored light strikes an object?
Teacher Preparation Body Of Evidence Est. Time
» Watch Video Demo of Inv.2 Part 2 |»> Reading: FOSS Student text Throw a Little Light on Sight 6 sessions
» Review “Materials” and “Getting pg 29
Ready” » Review Questions from video
» Notebook Investigation Entry
» Prepare materials » Journal Entry
» Student Observation/Anecdotal Notes
» Show video about light » Homework (Suggestions)
» I-check 2
» Administer and record I-Check 2 » Cross Curriculum Extensions Interdisciplinary Extensions

Suggested Center Activities: Rising Reader Readorium, Spelling City; FOSS Digital Resources: eBook, Audio Stories;
suggested websites; word wall activities; extension activities; and additional supporting Science activities.
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Investigation 3 — Matter

Summary

Students work with different states of matter, measure mass and volume using metric standards and tools, and solve
problems using their knowledge of metric measurement. They develop a set of defining characteristics for states of
matter. They read about the difference between opinion and evidence.

YVVY

Concepts

The behavior of a sample of matter in an open container indicates its state.
The gram is the standard unit of measurement used to quantify mass in the metric system.
Volume is a measure of the three-dimensional space occupied by matter.
The liter is the standard for measuring fluid volume in the metric system.

New Vocabulary Investigation 2

Balance, capacity, gas, graduated cylinder, gram (g),
kilogram (k), liquid, liter (1), mass, matter, metric system,
milliliter (ml), prediction, solid, state, syringe, volume

Extensions

Math - Problem of the Week pg. 53 Science Resources
Estimate Capacity of other containers

Science- Determine Volume of Solid Objects
Language- Discuss Metric Prefixes

Part 3.1 “Fact of the Matter”

Summary

Students sort a variety of materials based on state, solid, liquids, and gas. They summarize the properties of the different
forms of matter and develop a set of defining characteristics for each.

Understandings

» Common matter on Earth has three forms (states): solid, liquid, and gas.

» The behavior of a sample of matter in an open container indicates its states.

Focus Questions

What are the properties of solids, liquids, and gases?

Teacher Preparation

Body Of Evidence

Est. Time

» Read TE
“At A Glance”, “-Background for
the Teacher-solids, liquids, and
gases”&“Teaching Children About
Matter”

» Watch Video Demonstration of Inv.
3 Partl

» Review
“ Materials” “Getting Ready”
&“Guiding the Investigation”

Prepare materials

» Reading: FOSS Student text Ice is
States of Matter pg. 39

Writing Prompt: Review

Questions pg. 42,

Notebook Investigation Entry

Journal Entry

Student Observation/Anecdotal

Notes

Homework (Suggestions)

YV VYVV V

3 sessions

Suggested Center Activities: Rising Reader Readorium, Spelling City; FOSS Digital Resources: eBook, Audio Stories;
suggested websites; word wall activities; extension activities; and additional supporting Science activities.

Culminating Activity: Continue to work on projects.
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Part 3.2 “ Weighty Matters”

Summary
Students learn the concept of mass — the stuff of the world. — and how to measure mass by weighing. They weigh a metal

disk in paper-clip units. After reporting the mass of the metal disks in paper-clips, which are different sizes, students
recognize the need for standard unit of measure. The gram is introduced. After determining the mass of water a sponge
can soak up, students read a related article.

Understandings
» Measurement is used to quantify observations.
» A measurement standard is a unit agreed upon and used by a large number of people.
» The gram (g) is the standard unit of measure used to quantify mass in the metric system.
» Volume is a measurement of three-dimensional space occupied by matter.
» Opinion is based on belief; scientific evidence is based on observation.
Focus Questions
» What is mass?
» How can you measure the mass of an object?
Teacher Preparation Body Of Evidence Est. Time
» Read TE » Reading: FOSS Student text 4 sessions
» Watch Video Demonstration of Inv. Oponions and Evidence pg. 43
3 Part2 » Writing Prompt: Review
» Review Questions pg. 46
“ Materials” “Getting Ready” Notebook Investigation Entry
&“Guiding the Investigation” Journal Entry
» Prepare materials Student Observation/Anecdotal
Notes

Homework (Suggestions)
Cross Curriculum Extensions
Informational Text Reading

VVV VYV

Part 3.3: “A Matter of Volume”

Summary
Students learn the conventions associated with measuring fluid liquid volume. Different-size vials, used as units to

measure the capacity of a plastic cup filled with water, help establish the need for a standard unit of volume. The liter and
milliliter are introduced.

Understandings
» A measurement standard is a unit agreed upon and used by a large number of people.
» The liter (L) is the standard for measuring fluid volume in the metric system
» Common matter on Earth has three forms (statesa0: solid, liquid, and gas.
Focus Questions
» What is volume?
» How can you measure the volume of a liquid?
Teacher Preparation Body Of Evidence Est. Time
» Read TE » Reading: FOSS Student text The Metric 6 sessions
» Watch Video Demonstration of Inv. 3 Part3 System pg. 47
» Review » Writing Prompt: Review Questions pg. 53
“ Materials” “Getting Ready” &“Guiding the » Notebook Investigation Entry
Investigation” » Journal Entry
» Prepare materials » Student Observation/Anecdotal Notes
» Administer and Record I[Check 3 » Homework (Suggestions)
» I-Check 3
» Cross Curriculum Extensions
» Informational Text Reading
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Investigation 4
Changing Matter

Summary

Students use a thermometer to measure and record temperatures as they explore melting of common
substances. The class conducts an evaporation investigation, and students use the data to draw conclusions.
Students combine substances and observe the results of a chemical reaction. They read about solids,

liquids, and gases and about reactions.

Concepts
» Degree Celsius is the unit used when scientists measure temperature.

» Melting occurs when solids are heated. Different substances melt at different temperatures.
» When two substances are combined, a reaction may occur, producing a new substance with unique

properties.
> All matter 1s made of particles.

New Vocabulary Investigation 4 Extensions
Carbon dioxide, degree Celsius (C°), evaporation, melting, | Science Extension- Conservation of Matter

particle, reaction, substance, temperature, thermometer

Partd. 1:.”’Measuring Temperature”

Summary

Students are introduced to the concept of temperature and the tool used for measuring temperature, the thermometer.
Students compare the temperature of three cups of water using their fingers as gauges. They realize a standard is needed as

well as a more accurate devise to meassurde temperature.

Understandings
» A measurement standard is a unit agreed upon and used by a large number of people.

» Degree Celsius is the unit used when scientists measure temperature.
» Melting occurs when solids are heated.
» Different substances melt at different temperatures.

Focus Questions
How can you measure the temperature of a liquid?

Teacher Preparation Body Of Evidence Est. Time
» Read TE » Notebook Investigation Entry 1 sessions
“At A Glance”, “-Background for the » Journal Entry
Teacher (Heat and temperature)”’&‘“Teaching » Student Observation/Anecdotal Notes
Children About Changing Matter” » Homework (Suggestions)
» Watch Video Demonstration of Inv. 4 Partl » Cross Curriculum Extensions
» Review » Informational Text Reading
“ Materials” “Getting Ready” &“Guiding the
Investigation”
» Prepare materials
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Investigation 4: Part 2. Waterwheels

Summary
Students put samples of chocolate, margarine, wax, and a pebble in a cup. They place the cup in hot water and observe

what happens to the samples. This is followed by a demonstration of transferring heat to liquid water and comparing the
amount of evaporation to a similar cup that was not heated.

Understandings

Evaporation occurs when liquids are heated
All matter on Earth is made of tiny particles.

How can you melt a solid?

>
>
Focus Question
>
» What happens to the water in a container if you leave it out and heat it up?

Teacher Preparation Body Of Evidence Est. Time

»  Watch Video Demo of Inv.4Part Reading: FOSS Student text Change of State pg. 54 4 sessions
2 Writing: Summary questions pg 62
» Review “Materials” and Notebook Investigation Entry

“Getting Ready” & “Guiding Journal Entry
the Investigation” Student Observation/Anecdotal Notes
Homework

VVVVYVYVYV

Prepare Materials Cross Curriculum Extensions

Investigation 4: Part 3. Water from Home

Summary
Students conduct the vinegar and baking soda reaction. They determine the mass of the starting substances, predict what

will happen to the mass when the two are mixed, and then determine the mass of the products. They learn that new
substances form when baking soda and vinegar are mixed, and the loss of gas to the atmosphere accounts for the observed
loss of mass.

Understanding
> When two substances are combined, a reaction may occur, producing a new substance with unique properties..

Focus Question
What are some of the properties of water that affect its quality?

Teacher Preparation Body Of Evidence Est. Time
» Watch Video Demo of Inv.4Part 3 » Reading: FOSS Student text Reactions pg 60; 6 sessions
» Review “Materials” and “Getting Summary: Changing Matter pg. 63

Ready” & “Guiding the Writing: Summary questions
Investigation” Notebook Investigation Entry
Journal Entry
Prepare Materials Student Observation/Anecdotal Notes

1I-Check 4 and End of Unit Assessment
Homework

Cross Curriculum Extensions

End of Unit Assessment

Administer and record I-Check 4 and end
of unit assessment

VVVYVVYY

Suggested Center Activities: Rising Reader Readorium, Spelling City; FOSS Digital Resources: eBook, Audio Stories;
suggested websites; word wall activities; extension activities; and additional supporting Science activities.

Culminating Project: Students complete project, and present to class

Unit ends June 19", 2015 . The Unit takes an estimated 41 session and there are sessions scheduled. (3 additional
science days built in)
Session = 45 minutes
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Assessments:

The following items are to be tracked by the teacher and recorded in Genesis for administration and parents to view.

Writing prompts
Notebook Investigation Entry
Journal Entries
Student Observations
Anecdotal Notes
Homework
Summative Assessments:
Pre-assessment, I-checks, End of Unit assessments, Post Assessment (data to be recorded)

This guide is intended to support the collection of a Body of Evidence. A student’s Body of Evidence should, at a
minimum, include work form the listed prompts and in-class investigations that demonstrate a student’s level of

proficiency. The FOSS pre-assessment given at the beginning of the unit, the I-checks given after each investigation and

Grade 3 DISTRICT Earth Science Benchmark Assessment given at the end of the unit (Post-assessment) may also be
included in the body of evidence.
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Materials Sheet

Be aware that the classroom teacher or school site must supply a few items. Here is a summary of supplies not included in
the kit.

DRAWER 1 - PERMANENT EQUIPMENT

Quantity Item Description Inventory Checklist
8 Balances with pointers
200 Gram pieces, multicolored
1 bag Gravel, 1.2 kg/bag
2 Mass sets, 35/set
1 Meter tape
2 Pitchers
1 Poster, FOS5S Safety
1 Transparencies set, 3/set
1 Video, All about Light (DVD)
1 Video, All about Solids, Liquids, and Gases (DVD)
1 Video, All about the Transfer of Energy (DVD)
1 Teacher Guide
1 Teacher Preparation Video
. FOSS Science Resources books, Matter and Energy
DRAWER 2 - PERMANENT EQUIPMENT
8 Basins
1 Beaker, 1-liter
8 Beakers, 100-mL
10 Cloth pieces, knit, 10 cm (4") square
16 Containers, 1/2-liter
8 Containers, 1-liter
10 Disks, metal
8 Graduated cylinders, 50-mL
1 Marking pen, permanent, fine-point
100 Paper clips, large
200 Paper clips, regular
10 Plastic chips
a0 Plastic cups
1 cont. Rice, 350 g/container
8 Sponges, small
1 Spoon set, 1, 2, 5, 15, 25-mL
2 Spoons, 5-mL
a8 Syringes, 50-mL
16 Thermometers, Celsius, alcohol
] Vials, 12-dram, with caps
] Vials, 7-dram, with caps
10 Wood squares
50 Zip bags, 1-liter
20 Zip bags, medium
24 Zip baas. small
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DRAWER 3 - PERMANENT EQUIPMENT

Quantity ltem Description Inventory Checklist
32 AA-cells
1 Basin, clear
2 Batteries, 9-V
1 Bottle, 1-iter, red
1 Bubblewrap sheet
16 Cardboard tubes, 1.5" diameter, w/ hole and cap
16 sets Colored gels (green and red)
10 Craft sticks
16 Energy card sets
16 Flashlights, small
1 Funnel
1 Lamp with 75-waitt bulb
32 Mirror clips
32 Mirrors, plastic
] Motors, 1.5-V, with wire leads
1 bag Pebbles, small, 0.5 kg /bag
100 Rubber bands, #14
2 Solar cells with leads
1 Spring toy
2 Table tennis balls
2 Tennis balls
2 Tone generators, FOSS
1 box Toothpicks, flat, 750/box
10 Tubes, plastic, 5 cm, (2") long
a0 Vials, plastic with screw caps, 30-mL
a8 Wires, #14, solid, insulated, 13 cm
DRAWER 3 - CONSUMABLE ITEMS
1 cont. Baking soda, 450 g/container
1 box Birthday candles, dripless
1 bag Sand, 0.75 kg /bag
2 pads Self-stick notes, 100/pad
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Unit Resources:

Content books-

FOSS Student Book with Unit

e See Reading Extensions in TE
e FOSS Reading Supplemental Books
e  Sun, Moon and Stars Series

FOSS Website:

www.fossweb.com (additional resources and web sites found there)

Spelling City:
www.spellingcity.com

United Streaming Videos
http://www.discoveryeducation.com//?ref=streaming&returnUrl=http%3 A%2F%2Fstreaming%2Ediscoveryeducation%?2

Ecom%?2Findex%2Ecfm

Brainpop (see if your school has license for this)
http://www.brainpopjr.com/
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